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ID-AL products are exclusively manufactured by Waves System
LAVILLE EN BOIS - 44830 BOUAYE - FRANCE

Sales and information: +33 240 78 22 44

E-mail : info@id-al.com

Web site: http://lwww.id-al.com and www.wsystem.com

Technical department : support@wsystem.com

Technical support :
For a detailed list of the technical support options, we suggest you to visit our site
www.id-al.com.

Information in this manual is subject to change without notice and do not represent any commitment from
Waves System. The equipment described in this manual is supplied under condition of the terms of
license specifying the legal use conditions. This manual can’t be reproduced or used, in whole or in part,
in any form and by any mean, for other use than private, without the written permission from Waves
System.

ID-AL is a trademarks of Waves System.
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ID-AL Scheduler V1.x

Introduction

What is the "ID-AL Scheduler" software ?

The ID- AL players can be programmed to define a customized broadcast pattern: play adverts at given
dates and times, change music style, start lights & sounds shows, start and stop the player automatically...

The "Schedule" of the ID-AL player will therefore consist of a series of actions, each action defined by
its trigger mode and the command to be executed.

The ID-AL Scheduler software is an assistant designed to create actions, based on date and time, and
generate the associated programs for the ID-AL compatible products.

Minimum Configuration required

. Processor 800 Mhz

. Windows compatible sound card

.128 Mo Ram

. 1 Mo available space on the disk for software installation
. Microsoft Windows XP or Vista

. Microsoft Framework .NET 2.0 or latest version

Program Installation

1. Click on the installation icon named ‘Install IDAL Scheduler’.
Note: the program is available for download from the www.id-al.com web site.

Important : make sure that the Firmware version of your player is compatible with the version of ID-AL
Scheduler to be installed.

2 . Select the language for the installation assistant and click on OK.
3 . The installation assistant will be launched, follow instructions and select options when invited.

4 . In the last window, click on Finish to complete installation.

Overview

The ID-AL Scheduler is a user friendly software which includes many efficient tools to create automation
programs for the ID-AL players. The following sections describe the environment of the ID-AL Scheduler
software.
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Main Window

This window appears when the ID-AL Scheduler is opened.
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Tool bar

The tool bar allows quick access to the most frequently used functions.

Material EventPlayer | _|_"| Iy ’EJ |l%'-|'l ﬁ | E | & 14 ,*." @ 6:23

| | Create a new project

| ] Open a project

[g! Save project

E% Add an action
ﬁ Delete an action

E Display typical day details
% Display calendar

@ Display previous month
A= Zoom -
1:1 Display full day

+

#=  Zoom+

@ Display next month
Material EventPlayer shows the material used for the project

E 23 Displays the time associated to the position of the mouse on the calendar.
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Get started

The ID-AL Scheduler is a user friendly programming tool designed for compatible ID-AL players. This
section describes the basic functions of the software.

Software and hardware configuration
Before starting, make sure that both software and hardware are correctly configured.

Transfer of programs into the player

The programs created using the ID-AL Scheduler are saved as a file which will be copied onto the
storage media read by the player. Copy could be via the USB link, directly onto the support itself (USB
stick, SD card, hard disk... ) or Ethernet link ...

Software configuration
No other setting is necessary other than selecting the language. As soon as open, the software is ready
to use.

Principles for project creation
A project is based on the creation of "typical" days which are then placed onto the calendar.

Programming stages:

1 - Create one or several typical days (week, week-end, bank holidays...)
2 - For each typical day, create the desired actions at selected times

3 - Position the typical days created onto the calendar

4 - Save the file and transfer it onto the player's storage media (USB stick, SD Card, Hard disk...)
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Creation a project

1. In the File menu, choose New Project or clic on |__L|

2. The window New Project opens up

£2 New project E@@ A New project

haterial Il | Idaterial |EventPlayer v
Project name | | Project name | Show IDAL

puthor | Buthor DAL

Creation date | Creation date 20 Feb 2009

Consumer | Consumer :_-My customer

Comments ) Corrents

| iCommemforthis prmacﬂ

el Fene

Mandatory field: Material type

- Select the material to be used in the list.

If the chosen material is not listed, it is either not compatible with the ID-AL Scheduler or you do not have
the latest version of the software. Visit the download section of the ID-AL web site www.id-al.com to
obtain the most recent version.

Optional fields: Information fields

- Fill in the other fields: name of project, author, date, customer, comments.

Click on OK.

The information fields of a project can be modified at any time in the File MENU, select Project Properties .

Save a project
Your work is saved on the computer as a project file (.tm2) which can be re-opened later. This project file
will be used by the player to execute the programs according to the created broadcast schedule.
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1. Choose Save in the File menu or click on

2. Select a drive and a directory to save the project into
3. Enter the chosen project name in the File Name window

4. Click on Save

Add a typical day

In the Edit menu, select Create typical day

B= ID-AL Scheduler

File | Edit | Options  Help
Mate Create tvpical day
Open tvpical day

Save typical day

i3

Delete typical day

PIX]

Calours
Ul N )
NN
ENNEENEN
ElEEENNEN
ENEEEEEN

B 4 il B

Colours
N
|

[ Define  colours 3 l
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Choose a name for the typical day and, if so wished, associate a colour code by clicking on the colored
box to open up the range of colours. Select colour and click on OK to validate the colour.
Click on OK to validate the typical day.

The typical days created are listed by names and colour codes in the Typical Days section, in the column
on the top left of the screen.

Journée bype
B Lundi
B semai
=

B Dimanche
[ Jour Férié

Renaming a typical day or changing its colour
Double click on the name in the "Typical day" section in the column on the left. The name and colour code
of the typical day can be modified in the window which opens up.

Add actions in a typical day

To add actions at selected times in a typical day:
1 - Select the typical day in the Typical Days column by clicking on its name

2 - Position the cursor in the middle of the desired time zone. The exact time is displayed on the top, next
to the tool bar.

3 - Double click to open the Creating an Action window.
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C[E[x]

Fils Edit Options Help

Material EventPlayer | [ [ [ |5k 8 |0 E |© 211 2 ©

1:00
List of Actions. _—
Creating an action
00 Hour Ordering Yalue

| [Diectoy v [ \L’
Description
i 00 - 1 Cancel
- * i L 7‘

January 2009

SMTWTEFS
iH 3 5:00 © Mo repeat

45678910 [io & -

1112 13 14 1516 17 Sl o Bl

181920212223 24 00

25 26 27 28 29 30 31

Repeat mode

February 2009
SMTWTFS

7.00
1234567
8 910111213 14
1516 17 18 1920 21

&00

222324252627 28
March 2009

SMTWTF S
123456867 9:00
15 16[i7 18 19 20 21
222324252627 28
293031

1000

11:00

Make the necessary modifications:
- Change time of action if required
- Choose the command to be executed

Directory -> Select the directory to be read
Command -> Play, Stop, Pause

- If you have selected "Directory”, select the directory number in the list.
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Repeat mode for an action:

To facilitate creation of repetitive actions during the same day, a repeat mode is available.
Example : If you want to read the same file in directory 001 every hour between 9h00 and 19h00.
- Start time is the time indicated in the action creation window

- Select the "Directory" order and enter Value "001"

- Click on the Repeat mode and select the frequency: every X minutes

- Enter the end time at 19h00
- Click on OK to validate

reating an action @

Hour Ordering Value

IS:UU v | |Directory v | !EIEI'I w | oK
Description
|Message eveny houl |

Repeat mode

) Ma repeat
S ; : PR |
@® Ewery !—BD v |  Minutes until i_‘ID.DD |

=

it Chton Cpaenr Mde
Matdeed EesmiPlares | bl b B
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Modify an action

1 - To modify the starting time of the action

Just keep on pressing the action line (cross cursor) and move the line up or down to modify the time. The
new value is displayed on the action line.

1300

1400
| 14:00 : Répertoire 000

15:00

2 - To modify parameters of the action

Double click on the action line to open the Properties window, modify parameters as required and
validate.

Delete an action

Click on the action line to be deleted and press the "Del" key of the keyboard or click on ﬁ

Quickly place an action from the list of actions

A "List of actions" area is displayed in the column on the left, under the "Typical day" section. This list is
automatically updated when commands are being used during the typical day.

To place a new action in a typical day, select the desired action in the list and drag/drop at the required
time on the typical day.

List of Actions

| Drirgechary 001
| Directory 005 —————— Drag and drop an action in the typical day
| Stand by

| Directony 354

The "List of actions" zone can be hidden by un-ticking the box next to the title.
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Organization of typical days in the calendar

Once all the typical days have been created, you need to position them in the calendar. It is possible to
program actions weeks, months, years ahead ... for example to organize a promotional campaign, plan
for bank holidays, seasonal events, Christmas period....

1 - Click on % to switch to calendar mode

= ID-AL Scheduler, (=13
File Edit  Options Help
Material EventPlayer | I:'] Fa |%l ﬁ B E & 211 5O

ypical day. February 2009
B Monday
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| Directary 354 o 3 4 5 & E a
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- + -
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120y
S e & 7 E a 10 1 12
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Add typical days in the calendar

To organize typical days in the calendar:
Drag/drop the typical day in the selected date box

Multiple selection:
Keep the "Ctrl" key down and click on the selected dates (calendar boxes) to make multiple dates

selection.
It is also possible to click on one first date and move the mouse to adjacent boxes. The selected boxes

are shaded.

£ ID-AL Scheduler

File Edit Options Help
Material EventPlayer | [ 7 [l |5F 88 [ B | @ 10 2 ©

February 2009

B Monday

B week Monday Tuesday wWednesday Thursday Friday Saturday Sunday
[ saturday February 1
= Monday Week Week g Sunday

unday

List of Actions

Directory 001
Directory 005
Stand by

Directory 354

- + -

January 2009

SMTWTF S5
L2

456 78 910
111213 14 15 16 17
18 19 20 21 22 23 24
250 Al

February 2009
SMTWTEFS

11 12 13 14 15 16 17

18 19 20 21 22 23 24

= 26 27| 28 20 30 31
June 1 Z 3 4 = 6 7
Fl a 10 11 12 13 14

ik 16 ity 18 19 20 21

z 23 24 25 26 27 28

29 an July 1 2 3 4 15

® Waves System -13- V 1.0 - 2009



L.D. AL - Time & Date Programming IDAL Scheduler - User manual

Repeat mode of a typical day:
To repeat a day over long periods of time:

1 - Double click on a date when the typical day is applicable
2 - Choose a repeat mode:

- Every day until a specified date

- Every x days until a specified date
3 - Click on OK to validate

Repeat mode 16/03,/2009

() Norepeat
(3} Ewery day until ]BFD?QDM =
Ofvey 7 S| Ul 16032008 ]

Example: If you wish to repeat the typical day every week, for example every Monday, select repeat
mode "Every 7 days" until "date of your choice".

Delete a typical day on a date
Click on the date box to select and press on the "Del" key of the keyboard.

Secondary Calendar
You can also check or add a typical day on the miniature calendar displayed in the column on the left of
the screen.

February 2009 February 2009
SMTWTFS SMT
1 234567
8 91011 12 13 14

(1817 18 19 20 21
22 23 24 25 26 27 28
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Details of the various menus

FILE Menu

£= ID-AL Scheduler

File | Edit Options  Help

Mew project =
Project properies

Qpen project
Save project

Save project as

Print tvpical day

Print calendar

it 16

EDIT Menu

File m Optionz  Help
Mate Create typical day | % i
T Open typical day

1

Save tvpical day
Delete typical day

OPTIONS Menu

£2 ID-AL Scheduler
File Edit

_Options
Material Ex Language

ical d katerials
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Generate the programming file

When all the timer programs are finalised, you need to save the work.

1 - Save the project and give it a name of your choice. DO NOT CHANGE the extension ".tm2"
2 - Identify the location of the file on the computer

3 - Copy the file at the root of the storage media used by the EvenPlayer, SD card, USB stick , HDD...
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SYSTEM
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http://www.id-al.com

http://www.wsystem.com
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